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RTPView Project Program 
Hardware Setup 

 ● No physical I/O hardware is required to perform this setup example.  You are free 
to use either an RTP target node or the NetArrays built-in Simulator. 

NetArrays Project 

 ● Start NetArrays.  On your PC, press  Start and select ProgramsRTP 
NetSuiteNetArrays.  Open the NetArrays program “My_first.dbn” that was 
created in the Example “NetArrays Project Development”.  If you have not 
previously created this program, do so now.  Left click on File and select Open 
Project… 

 

 ● Select the My_first.dbn and left click Open. 
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 ● In the NetArrays Device menu, select Select and choose the target node you 
are using to run this example, or the local Simulator.  In the NetArrays Device 
menu, select Download Project to download and run your project on the selected 
device. 

 

  

 ● When prompted select Yes for Do you want to overwrite? 
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 ● Examine the Output Window to confirm that the download was successful.  This 
project program must remain running in the target node or Simulator while you 
complete the rest of this setup example. 

 

Examine Output 
Window 

Download 
complete 
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RTPView Project 

The RTPView project will contain a Fader slide bar and a Key Switch that write data to 
the NetArrays project program.  An Edit Box, a Tank, a Temperature Gauge, and a Trend 
object will read data from the NetArrays project program.  An RTPADA object will display 
alarm information created by an RTPADA application.  An example using a Popup 
window will be shown. 

 ● In the NetArrays toolbar, left click the  button to launch RTPView. 

 ● In RTPView, on the  (New Project) button to begin a new project. 

 

 ● Select No to the question: Project has been modified. Save Changes? 

 

 

New Project 
Button 

Edit Box Button 
Picture Button 
Gauge Button 

Object Size 

Position 

Trend Button 
Run 

RTPADA Button 
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Fader 

The Fader consists of a static Scale picture object, a Pointer picture object that drives a 
variable in the NetArrays project program, and an Edit Box object that reads the Fader 
position from a variable in the NetArrays project program. 

Fader Scale 

 ● Left click on the  (Picture) button in the Palette toolbar.  Move the cursor near 
the upper left corner of the page and left click the left mouse button.  A dark gray 
rectangle will appear on the page. 

 ● Right-click on the rectangle and select Object Properties from the menu.  This will 
display the Object Properties dialog. 

  

 ● Left click on the Image tab of the Properties dialog.  From the Category list, select 
Scales.  From the list of Pictures, select Scale2(0-2-50).bmp.  The picture will 
appear in the Preview frame. 
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 ● Left click the OK button to close the Properties dialog. 

 ● Select the Scale object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Scale to 20 x 200 pixels.  Release the Shift key and use the 
arrow keys to position the Scale at coordinates 60, 30.  It should look like the 
following example.  The object size and coordinates can be viewed in the bottom 
right corner of the RTPView window. 

 

 

Fader Pointer 

 ● Left click on the  (Picture) button in the Palette toolbar.  Move the cursor near 
the top of the Scale and left click the mouse button.  A dark gray rectangle will 
appear over the scale. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

Select 
Scale2(0-2-50).bmp 

Select Scales 
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 ● In the General tab of the Properties dialog, select Read/Write as the Data 
property.  Check the check box to the left of Repeat write while mouse button is 
pressed.  RTPView will write the output of this object as it is being moved. 

  

 ● Left click on the Image tab of the Properties dialog.  From the list of categories, 
select Misc.  From the list of Pictures, select needleBlue.bmp.  The picture will 
appear in the Preview frame. 

  

 ● Left click the OK button to close the Properties dialog. 

 ● Select the Pointer object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Pointer to 30 x 15 pixels.  Release the Shift key and use the 
arrow keys to position the Pointer at coordinates 36, 26.  This positions the Pointer 
at the top of the Scale. 

 ● Right-click on the Pointer object again and select Object Properties from the 
menu. 

 ● Left click on the Motion tab of the Properties dialog.  Check the Enable checkbox 
to enable motion control for the object.  Select Up as the Move property.  Leave the 
Min Value at 0 and the Max Value at 100. 

Select 
needleBlue.bmp 

Select Misc 

Select Read/Write 

Check 

Repeat Box 
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 ● Left click the OK button to close the Properties dialog. 

 ● Drag the bottom anchor point of the Pointer down to just below the bottom of the 
Scale and release it.  This determines the motion length for the object.  In run 
mode, sliding the pointer up and down the track will create a value ranging from the 
defined minimum to the defined maximum. 

   

 ● Right-click on the Pointer object and select Data Properties from the menu. 

 ● Left click on the Tag column and select Fader from the list of tag names.  Left click 
the OK button to close the Data Properties dialog.  The Device will automatically 
be set to Simulator (or the device with the downloaded program). 

Fader Output Edit Box 

 ● Left click on the  (Edit Box) button in the Palette toolbar.  Move the cursor under 
the bottom of the Scale and left click the mouse button.  A light gray rectangle will 
appear below the Scale. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property. 

Stretch Pointer 
Down to Here 

Check Enable 

Select Up 
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 ● Left click on the Text tab.  Press the Font button and change the Font settings to 
Arial, Bold, 12.  Left click the OK button the close the Font dialog. 

 ● Left click on the Color button and select Red for the text color.  Left click the OK 
button the close the Color dialog. 

 ● Select Center for the Alignment and Raised for the Border type. 

  

 ● Left click on the Format tab.  Select Float as the text Format, and 0 for the number 
of Decimal Places.  Left click the OK button the close the Object Properties dialog. 

Select Read 

Select Red for Color 

Select Arial, Bold, 12 

Select Center 

Select Raised 
for Border 
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 ● Right-click on the Edit Box object and select Data Properties from the menu. 

 ● Left click on the Tag column and select Fader from the list of tag names.  Left click 
the OK button to close the Data Properties dialog.  The Device will automatically 
be set to Simulator, if that is the device with the downloaded program. 

  

 ● Resize the Edit Box to about 50 x 20 pixels and position it under the center of the 
fader scale.  The completed Fader assembly should look like the example shown 
below. 

Select Float 

Change to 0 

Select Fader 

as the Tag 
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Resize and 
Position Here 
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Key Switch 

The Key Switch is a button Picture object that turns the Tank Mixer on and off. 

 ● Left click on the  (Picture) button in the Palette toolbar.  Move the cursor to the 
right of the Fader and click the left mouse button.  A dark gray rectangle will appear 
on the page. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read/Write as the Data property.  
This object will write a Boolean value to the NetArrays project. 

 ● Left click on the Image tab.  Select Buttons as the Category.  Select 8 Slot with 
key turned vertical.bmp as the picture.  The bitmap of the key switch will appear 
in the Preview frame. 

  

 ● Left click on the scroll down arrow just to the right of the Preview frame.  The 
caption Image #1 will appear in the Preview frame.  Select 8 Slot with key turned 
horizontal.bmp as the Picture.  The second bitmap of the key switch will appear in 
the Preview frame. 

 ● Change the entry in the Value field below the Preview to 1. 

Select Buttons 

Select 8 Slot with 
key turned 

vertical.bmp 
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 ● Left click on the Button tab.  Check the Enable checkbox to allow the picture 
object to function as a button.  Select Toggle as the button Type.  Each time the 
object is clicked, its output changes state. 

  

 ● Left click on the OK button to close the Object Properties dialog. 

 ● Select the key switch object and resize it to about 52 x 52 pixels.  Move the object 
to coordinates 172, 25.  It should look like the example shown below. 

   
 ● Right-click on the Picture object and select Data Properties from the menu. 

 ● Left click on the Tag column and select Key from the list of tag names.  Left click 
the OK button to close the Data Properties dialog.   

  
 

Click Here 

Select 8 Slot with 
key turned 

horizontal.bmp 

Enter 1 

Check Enable 

Select Toggle 
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Tank 

The Tank consists of a static Tank picture image, a Cutaway fill picture, and a Mixer 
picture image. 

Tank Image 

 ● Left click on the  (Picture) button in the Palette toolbar.  Move the cursor to the 
right of the Key Switch and click the left mouse button.  A dark gray rectangle will 
appear on the page. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● Left click on the Image tab.  Select Tanks as the Category, and Tank 22.bmp as 
the Picture.  The bitmap of the tank will appear in the Preview frame.  Left click the 
OK button to close the Object Properties dialog. 

  

 ● Select the Tank object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Tank to 100 x 155 pixels.  Release the Shift key and use the 
arrow keys to position the Tank at coordinates 230, 70.  The Tank should look like 
the example shown below. 

   
 

Select Tanks 

Select Tank 22.bmp 
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Tank Cutaway 

 ● Left click on the  button in the Palette toolbar.  Move the cursor over the Tank 
object and left click the mouse button.  A dark gray rectangle will appear over the 
Tank. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property.  This 
object will be controlled by a floating-point value from the NetArrays project. 

 ● Left click on the BackColor button.  Select a contrasting Background color, such 
as the one shown below.  Left click on the OK button to close the Color dialog.  
This will be the color of an empty tank cutaway. 

  

 

Select Read 

Select Dark 
Gray as the 
Background 
Color 
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 ● Left click on the Image tab.  Select Tank Cutaways as the Category, and Jagged 
cut-away 3.bmp as the Picture.  The bitmap of the cutaway will appear in the 
Preview frame. 

  

 ● Left click on the Fill tab.  Check the Enable checkbox. Select Up as the Fill 
function.  Leave the Min Value and Max. Value fields at their default values (0 and 
100).  Left click on the Fill Color button and select Blue as the fill color.  Left click 
on the OK button to close the Color dialog.  Left click on the Display Value None 
radio button. 

  

 ● Left click on the OK button to close the Object Properties dialog. 

 ● Right-click on the cutaway object and select Data Properties from the menu. 

 ● Left click on the Tag column and select TankLevel from the list of tag names.  Left 
click the OK button to close the Data Properties dialog. 

 ● Select the cutaway and resize it to about 85 x 100 pixels.  Move the object so that it 
overlays the Tank as shown in the example below. 

Select Tank 

Cutaways 

Select Jagged 

cut-away 3.bmp 

Check Enable 

Select Up 

Select Blue 

for Fill Color 

Select None 
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Tank Mixer 

  The following will show how to add automation to RTPView by having different 
pictures linked to a controlling variable.  The example mixer has 4 positions driven 
by an integer variable stepping through values from 0 to 3. 

 ● Left click on the  button in the Palette toolbar.  Move the cursor over the Tank 
object and left click the mouse button.  A dark gray rectangle will appear over the 
Tank. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property.  The 
image displayed will be controlled by the Waveform Generator in the NetArrays 
project. 

  

 ● Left click on the Image tab.  Select Mixers as the Category, and Magnetic mixer 
1.bmp as the Picture.  The bitmap of the mixer will appear in the Preview frame. 

Resize and 
Position Over 
Tank 

Select Read 
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 ● Left click on the scroll down arrow just to the right of the Preview frame.  The 
caption Image #1 will appear in the Preview frame.  Select Magnetic mixer 2.bmp 
as the Picture.  The second mixer bitmap will appear in the Preview frame. 

 ● Change the entry in the Value field below the Preview to 1. 

  

 ● Left click on the scroll down arrow again.  The caption Image #2 will appear in the 
Preview frame.  Select Magnetic mixer 3.bmp as the Picture.  The third mixer 
bitmap will appear in the Preview frame. 

 ● Change the entry in the Value field to 2. 

Select Mixers 

Select Magnetic 

mixer 1.bmp 

Select Magnetic 

mixer 2.bmp 

Click Here 

Enter 1 
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 ● Left click on the scroll down arrow again.  The caption Image #3 will appear in the 
Preview frame.  Select Magnetic mixer 4.bmp as the Picture.  The last mixer 
bitmap will appear in the Preview frame. 

 ● Change the entry in the Value field to 3. 

  

 ● Left click on the OK button to close the Object Properties dialog. 

 ● Select the mixer object and resize it to about 30 x 145 pixels.  Move the object so 
that it appears over the Tank as shown in the following example. 

Select Magnetic 

mixer 3.bmp 

Click Here 

Enter 2 

Select Magnetic 

mixer 4.bmp 

Click Here 

Enter 3 
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 ● Right-click on the mixer object and select Data Properties from the menu. 

 ● Left click on the Tag column and select Mixer from the list of tag names.  Left click 
the OK button to close the Data Properties dialog.  

 

  

Resize and Position 
Over Tank 
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Temperature Gauge 

The Temperature Gauge displays Celsius temperatures derived from the Fader output in 
the RTPView project.  It is created with a Gauge object. 

 ● Left click on the  (Gauge) button in the Palette toolbar.  Move the cursor to the 
right of the Tank and left click the mouse button.  The Gauge object will appear on 
the page. 

 ● Select the Gauge object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Scale to 300 x 260 pixels. 

 

 

 ● Right-click on the Gauge and select Object Properties from the menu. 

 ● In the Annulars tab of the Properties dialog, left click on the Color button and 
select Blue as the color of the annular.  Left click on the OK button to close the 
Color dialog.  Change the Angular Dimensions Start parameter to -45 degrees 
and the Stop parameter to 225 degrees.  (Note that to enter a negative value, you 

must use the decrement key .  Positive values can be entered directly.)  Leave 
the Radius and Width Dimensions at the default values (100 and 4). 
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 ● Left click on the Background tab of the Properties dialog.  Left click on the Color 
button and select White as the background color.  Left click OK to close the Color 
dialog.  Leave the Border parameters at the default values (None). 

  

 ● Left click on the Digital tab of the Properties dialog.  Un-check the Enable 
checkbox to disable the digital value display. 

Select Blue as Color 

Change to -45 

Change to 225 

Select White as Color 
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 ● Left click on the Needle tab of the Properties dialog.  Un-check the Write data 
checkbox. This object will be reading data.  Change the Width to 6 pixels. 

  

 ● Left click on the Scales tab of the Properties dialog and enter the value -40 into the 
Limits Minimum field.  Leave the Limits Maximum field at its default value (100).  
Leave the Direction setting at Clockwise.  Change the Start Angle to -45 degrees 
and the Stop Angle to 225 degrees.  (Note that to enter a negative value, you 

must use the decrement key .  Positive values can be entered directly.)  Leave 
the Horizontal and Vertical Center Positions at the default settings (150 and 150). 

Un-Check Enable 

Un-Check Write data 

Change to 6 
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Change to -40 

  

 ● Left click on the Ticks tab of the Properties dialog and check the Labels checkbox.  
Change the label Position to 8.  Left click the Font button and change the Size to 
9.  Left click OK to close the Font dialog.  Left click on the Color button and select 
Blue as the color of the Ticks.  Left click OK to close the Color dialog 

 ● Change the Start Range to -40.  Leave the Stop Range and Delta at their default 
values (100 and 10).  Leave the Length Dimension at the default value (-10).  
Change the Width Dimension to 2. 

  

 ● Left click on the OK button to close the Object Properties dialog. 

 ● The temperature gauge should look like the example shown below.  Select the 
object and reposition it to coordinates 350, 5. 

Enter -40 

Enter -45 
Change to 225 

Check Box 

Change to 8 

Change Size to 9 

Change Color 

to Blue 

Change to 2 
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 ● Right-click on the Temperature Gauge object and select Data Properties from the 
menu. 

 ● Left click on the Tag column and select Celsius from the list of tag names.  Left 
click the OK button to close the Data Properties dialog. 
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Trend 

The Trend object will plot the values of the Fader and the TankLevel variables. 
 

 ● Left click on the  (Trend) button in the Palette toolbar.  Move the cursor below 
the other objects and left click the mouse button.  The Trend object will appear on 
the page. 

 

 ● Right-click on the Trend and select Data Properties from the menu. 

 ● Select Fader as the Tagname in the first row.  Select TankLevel as the Tagname 
in the second row.  The Device will automatically be set to Simulator (the device 
with the downloaded program).  Left click the OK button to close the Data 
Properties dialog. 

 

 

Select Fader 
as Tag 

Select TankLevel 
as Tag 
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 ● Right-click on the Trend and select Object Properties from the menu.  Leave the 
Min and Max entries at the default values of 0 and 100.) 

 

 

 ● Left click on the Frame tab.  Select Frame Color and chose Light Blue.  Click the 
OK button to close the Frame Color dialog.  Left click the OK button to close the 
Object Properties dialog. 
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RTPADA Display 

The following section will initiate RTPADA to create alarms for RTPView to monitor. 

 ● In the NetArrays toolbar, left click the  button to launch RTPADA. 

 ● Open the previously created RTPADA file Test. 

 ● Left click on the  (Run) button in the toolbar. 

 ● Verify that RTPADA is running by observing Online in the lower right hand corner.  
Alarms may or may not be observed depending on the value of the input variables. 

 

 

The following section will prepare RTPView to display the RTPADA alarms. 

 ● In RTPView left click on Project and Select Preferences. 

 

 ● Left click on the Alarms Tab and check Enable. 
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 ● Left click on Alarm Properties and ensure that Local is Selected.  Left click the 
OK button to close the Alarm Properties dialog.  Left click the OK button to close 
the Preferences dialog. 

 

 ● Left click on the  (RTPADA) button in the Palette toolbar and position the cursor 
below the Trend object.  Left click to place the object on the page.  With the mouse, 
grab the right center handle and make the RTPADA object approximately the same 
size as the Trend object. 
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 ● When RTPView is run and RTPADA reports and error, the alarms will be visible 
here.  This RTPView object provides the same view as the RTPADA Alarm 
window. 

At this point your project should look like the example below. 
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Popup Window 

The following section will show how to use a Button Picture to implement functions, 
specifically a Popup window. 

 ● Select Project and Insert Page. 

 

 ● In the page Data Properties, change Name to Popup.  Change Update Rate (ms) 
to 100, Check Popup Window, set X to 650 and Y to 100.  Left click on the OK 
button to close Page Properties. 

 

 ● Left click on the  (Edit Box) button in the Palette toolbar.  Move the cursor near 
the upper left hand corner of the Popup page.  A light gray rectangle will appear 
below the Scale. 
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 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property.  
Check Transparent Background. 

  

 ● Left click on the Text tab.  Press the Font button and change the Font settings to 
Arial, Bold, 12.  Left click the OK button the close the Font dialog. 

 ● Select Center for the Alignment and Raised for the Border type. 

  

 ● Left click on the Format tab.  Select Float as the text Format, and 0 for the number 
of Decimal Places.  Left click the OK button the close the Object Properties dialog. 

Select Read 

Select Red for Color 

Select Arial, Bold, 12 

Select Center 

Select Raised 
for Border 
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 ● Left click the OK button to close the Object Properties dialog. 

 ● Right-click on the Edit Box object and select Data Properties from the menu. 

 ● Left click on the Tag column and select Celsius from the list of tag names.  Left 
click the OK button to close the Data Properties dialog.   

  

 ● Position the Edit Box at 15, 15. 

 ● Right Click on the Edit Box and Select Copy. 

Select Float 

Change to 0 

Select 
Celsius as 
the Tag 
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 ● Position the Cursor to the right of the Edit Box, Right Click, and Select Paste. 

 

 ● Right-click on the Edit Box object and select Data Properties from the menu. 
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 ● Left click on the Tag column and select TankLevel from the list of tag names.  Left 
click the OK button to close the Data Properties dialog.  

 ● Position the Edit Box at 125, 15. 

 ● Return to Page 1 by clicking on Page 1 in the left pane. 

 ● Left click on the  (Picture) button in the Palette toolbar.  Move the cursor to the 
right of the Gauge and left click the mouse button.  A dark gray rectangle will 
appear on the page. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select RTPView as the Data property.  
This object will open the Popup window. 

 

 ● Select Image tab, category Buttons.  Select 1 Small Rect Button Up. 

 

 ● Left click the down arrow to show Image #1. 
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 ● Select 1 Small Rect Button Down, and change Value to 1. 

 

 ● Select the Button Tab. 

 ● Check Enable, type Toggle. 
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 ● Left click on the Caption tab and type in Popup. 

 

 ● Left click the OK button to close the Object Properties dialog. 

 ● Position the picture object at 650, 25. 

 ● Right Click and Select Data Properties.  Select Open Page for Command and 
Popup for Jump to Page. 
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 ● Left click the OK button to close the Data Properties dialog. 

  

In a similar fashion buttons can be added to do other functions such as Go to Page or 
open an Overlay page. 
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Finishing and Saving the Project 

Your finished project Page 1 should look like the example below. 

 

Page Properties 

 ● Right-click on any empty space within the page and select Data Properties from 
the menu. 

 ● Enter the value 100 in the Update Rate (ms) field.  This will speed up the 
execution rate and provide smother motion of the objects.  Left click on the OK 
button to close Page Properties. 
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This completes the RTPView project.  Save the project by clicking on File and select 
Save Project as…  Navigate to the RTPView directory, type in MyFirst, and left click 
Save. 

Verification 

Now that the RTPView project is completed, we will now run the project. 

 ● Left click on the  (Run) button in the toolbar. 

 ● Left click on the Fader pointer and drag it up to mid scale and release it.  Observe 
that the Tank appears to fill to the same level and that the Temperature Gauge 
needle moves to mid scale.  Also observe that the Trend object plots the values of 
both the Fader output and the level in the Tank. 

 ● Left click on the Key switch and the Mixer will start running sequencing through its 
four positions. 

 ● Move the Fader pointer to any other position on the scale. 

 ● The RTPADA object will display alarms as they occur.  The four alarm windows 
can be selected as in RTPADA operation. 

 ● Left click on the Popup button.  The Popup page will become visible. 

 ● If any of the objects do not behave as expected, stop the project and recheck the 
configuration of the object’s properties. 

 
 

Enter 100 


